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Fast Facts About Persian Cats

When Persians compete in juried cat shows, the Cat Fancier’s Association
recommends that this beautiful breed be judged on the following attributes:

Table 1
Persian Cat judging Scorecand

BodyPet ___________________________|PoimSore |

Hoad [inchiding size and thape of eyes) 3
Body Type (including shape, size, bone, and length of tail) 0
Cont 10
Balance 5
Refinoment &
Coler 20
Eye Color 10
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Example: You are citing information from
an article that John Smith published in
2010.

In-text citation:

In a survey of undergraduate students, Smith (2010) found that
most seniors read project instructions before starting an
assignment.

OR

One study found that some students will read project instructions
before starting an assignment (Smith, 2010).

Complete citation in References:

Smith, J. (2010). A case study of student learning. Fictional
Journal of Learning, 42 (2), 15-20.

How big is it!

L. “The Mall of America in Bloomington is

| the size of 78 football fields and has five
k‘ - 'I.
hundred stores, an aquarium, and an
amusement park inside the mall”
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MLA Citation 101

* The two parts of MLA documentation work together.
* [n-text Citations

— Let readers know that you have quoted, paraphrased, or
summarized information from an outside source. They appear in
the body of your paper right next to the information you're
including.

* Works Cited Page

— Is an alphabetical list (at the very end of your paper) of your
outside sources where readers can find the complete
bibliographic information for a specific source.

There are special requirements for using clip art and stock images in APA Style papers. Common sources for stock images and clip art are iStock, Getty Images, Adobe Stock, Shutterstock, Pixabay, and Flickr. Common sources for clip art are Microsoft Word and Microsoft PowerPoint. The license associated with the clip art or stock image determines
how it should be credited. Sometimes the license indicates no reference or attribution is needed, in which case writers can reproduce the image without any reference, citation, or attribution in an APA Style paper. Other times, the license indicates that credit is required to reproduce the image, in which case writers should write an APA Style
copyright attribution and reference list entry. Follow the terms of the license associated with the image you want to reproduce. The guidelines apply regardless of whether the image costs money to purchase or is available for free. The guidelines also apply to both students and professionals and to both papers and PowerPoint presentations. Although
for most images you must look at the license on a case-by-case basis, images and clip art from programs such as Microsoft Word and Microsoft PowerPoint can be used without attribution. By purchasing the program, you have purchased a license to use the clip art and images that come with the program without attribution. This page contains
examples for clip art or stock images, including the following: Image with no attribution required Image that requires an attribution If the license associated with clip art or a stock image states “no attribution required,” then do not provide an APA Style reference, in-text citation, or copyright attribution. For example, this image of a cat comes from
Pixabay and has a license that says the image is free to reproduce with no attribution required. To use the image as a figure in an APA Style paper, provide a figure number and title and then the image. If desired, describe the image in a figure note. In a presentation (such as a PowerPoint presentation), the figure number, title, and note are optional.
Figure 1 A Striped Cat Sits With Paws Crossed Note. Participants assigned to the cute pets condition saw this image of a cat. If the license associated with clip art or a stock image says that attribution is required, then provide a copyright attribution in the figure note and a reference list entry for the image in the reference list. Many (but not all)
images with Creative Commons licenses require attribution. For example, this image of a sled dog comes from Flickr and has a Creative Commons license (specifically, CC BY 2.0). The license states that the image is free to use but attribution is required. To use the image as a figure in an APA Style paper, provide a figure number and title and then
the image. Below the image, provide a copyright attribution in the figure note. In a presentation, the figure number and title are optional but the note containing the copyright attribution is required. The copyright attribution is used instead of an in-text citation. The copyright attribution consists of the same elements as the reference list entry, but in
a different order (title, author, date, site name, URL), followed by the name of the Creative Commons License. Also provide a reference list entry for the image. The reference list entry for the image consists of its author, year of publication, title, description in brackets, and source (usually the name of the website and the URL). To cite clip art or a
stock image without reproducing it, provide an in-text citation for the image instead of a copyright attribution. Also provide a reference list entry. Parenthetical citation: (Denali National Park and Preserve, 2013) Narrative citation: Denali National Park and Preserve (2013) Microsoft PowerPoint’s image-insertion feature makes it simple and quick to
add graphics to your presentations, but you don’t want to skip over one important step - giving credit where credit is due. You can reference images in PowerPoint through citations which give presentation viewers more details about what they’re looking at and also serve as some due diligence on your part. Use the American Psychological
Association, or APA, guidelines to ensure that your citations are formatted properly. Before you can cite images in PowerPoint, you need to insert them properly. Begin by starting Microsoft PowerPoint. Then, click one of the two text box placeholders on the slide and press the “Delete” key. Repeat to delete the other text box. Technically, these won’t
show up on your slide, but they just get in the way. To insert the image you want to cite, click the “Insert” tab, then click the “Picture” button below the tab. Navigate to the picture to cite and double-click the image and drag it into place on the slide. To add text to your slid, find and click the “Text Box” button on the ribbon. When the cursor turns into
an upside down cross symbol, drag the cursor to form the text box for the citation. You can always adjust the text box size when you see the citation size. Simply click inside the text box and type the last name of the image creator with a comma, such as “Pollock,” and type the artist’s first initial with a period, such as “Pollock, ]J.” Do not type the
quotation marks. With the artist's name in place, type an open parenthesis and type the date of the image creation. Type a closed parenthesis and then type a period, so the entire line so far looks like “Pollock, J. (1992).” Do not type the quotation marks. In the same text area, type the name of the image. Do not use capitals except for the first word.
Highlight the image name and click the “I” icon on the "Home" tab to make the title italic. Type an open bracket and type the type of image, such as "[Painting]" or "[Photograph]." Once the title is recorded, it is vital to mention where the image is displayed, then type a comma and the location of the facility, such as “Museum of Modern Art, New York
City.” Remember to type where you accessed the image from, which is a permissions statement or a credit back to the original website owner. Your complete citation looks like this: “Pollock, J. (1992). Splatter effects [Painting]. Museum of Modern Art, New York City. Permission to reprint by MOMA.” Remember that the image title, in this case
"Splatter effects," should be in italic font. It is important that the citation is the correct size for your slid. To adjust it, click and drag a corner of the citation text box and resize it as necessary. To change the appearance of the text in the text box, highlight it, click the “Home” tab and use the options in the “Font” section of the ribbon. If you already
have the image inside a PowerPoint presentation, skip all the setup steps and join in the instructions at the text box insertion point. In addition, not all of this information may be available on every image you wish to cite. Include what you can in the same formatting. 1 Provide a figure number for the image. Figures are labeled using the abbreviation
"Fig." followed by a sequential number. If it's the first image in your presentation, it would be "Fig. 1." Type both the abbreviation and the number in bold type. Place a period after the number.[2] 2 Include a title or description of the image. If the image is titled, type that title enclosed in quotation marks. If it doesn't have a title, provide a brief
description of the image. Then type the word "from," followed by a colon.[3] Example: Fig. 1. Pedestrians walking by street art graffiti of the word love from: Advertisement 3 Identify where you got the image from with a full citation. Include a full Works Cited entry for the source of the image in the image caption. MLA does not require an additional
entry in the Works Cited for your presentation.[4] Example: Fig. 1. Pedestrians walking by street art graffiti of the word love from: "Pedestrian Street Art Protest," 26 Dec. 2016, pxhere.com/en/photo/10722. Accessed 29 Oct. 2018. If the image is available online, include a direct URL to the web page where the image can be found, instead of a page
number. 4 Close with copyright or Creative Commons license status. If you have reproduced the image in your presentation slides, copyright or license details are required in the caption. Typically this information will be listed directly below the image. If you cannot find copyright or license details for the image, do not reproduce the image in your
presentation. Place a period at the end of the copyright or license information.[5] Example: Fig. 1. Pedestrians walking by street art graffiti of the word love from: "Pedestrian Street Art Protest," 26 Dec. 2016, pxhere.com/en/photo/10722. Accessed 29 Oct. 2018. Creative Commons CC0. MLA Caption Format Fig. x. Description of image from: Last
Name, First Name. "Title of Original Image." Publication, Day Month Year, p. x. Copyright or CC License. Advertisement 1 Label the image with a figure number. Immediately under the image, type the word "Figure" in italics, followed by a number for the image. Your numbers should be sequential throughout your presentation. Type the word and
number in italics. Place a period after the number.[6] 2 Provide a description of the image in your caption. The image in your presentation is a reproduction of the original. Since the title only applies to the original, APA style requires a description. Type your description in sentence case, capitalizing only the first word and any proper nouns. Place a
period at the end of your description.[7] Example: Figure 1. Cat watching World of Warcraft on a laptop. 3 Include information about where you found the image. Type the words "Adapted from," then provide the title of the image, the creator of the image, and the location of the image. Since typically you'll pull an image from the internet, include a
URL for the image.[8] Example: Figure 1. Cat watching World of Warcraft on a laptop. Adapted from "World of Warcraft Obsession," by Stacina, 2004, retrieved from . 4 Close with copyright or Creative Commons license information. Copyright or license details indicate that you have permission to copy the image and use it in your presentation. If the
image has a creative commons license, use the abbreviation listed. Place a period at the end of the copyright or license information.[9] Example: Figure 1. Cat watching World of Warcraft on a laptop. Adapted from "World of Warcraft Obsession," by Stacina, 2004, retrieved from . CC BY-NC-SA 2.0. APA Caption Format Figure 1. Description of image
in sentence case. Adapted from "Title of Original Image," by Artist, Year, retrieved from URL. 5 Include a reference list entry in addition to the caption. APA style does not require a full citation in the caption for the image. Rather, the full citation is included in your references. Follow the basic APA format for citing an image.[10] Example: Stacina.
(2004). World of Warcraft Obsession [photograph]. Retrieved from . APA Reference List Citation Format Artist Last Name, First Initial. Middle Initial. (Year). Title of image in sentence case [Description of format]. Retrieved from URL. Advertisement 1 Give the image a figure number. Begin your caption immediately under the image. Start the caption
by typing the word "Figure" followed by a sequential number. Place a period after the number.[11] 2 Provide a caption for the image. Include the title and name of the artist in your caption, writing a brief sentence that ties the image into the rest of your presentation. Depending on the image, the caption may also describe what is depicted in the
image, or how it is related to your presentation.[12] Example: Figure 1. The Banquet of Cleopatra by Giambattista Tiepolo depicts a contest between Cleopatra and Mark Antony. 3 Include a full citation for the image in a footnote. The superscript number for your footnote may be in the text of your presentation, or at the end of the caption. In the
footnote, list the name of the artist, title of the work, date of creation, and where you found the image. You may also include the dimensions of the original artwork and materials used, if relevant.[13] Example: Giambattista Tiepolo, The Banquet of Cleopatra, 1743-44, oil on canvas, 250.3 x 357.0 cm, accessed 24 May 2018, . For slide presentations,
you may use endnotes instead of footnotes, to keep your slides clean. The format remains the same. Chicago Footnote Format Artist First Name, Last Name, Title of Image, Year, materials, dimensions, accessed Day Month Year, URL. Advertisement Ask a Question Advertisement Thanks! Advertisement Co-authored by: Doctor of Law, Indiana
University This article was co-authored by wikiHow staff writer, Jennifer Mueller, JD. Jennifer Mueller is a wikiHow Content Creator. She specializes in reviewing, fact-checking, and evaluating wikiHow's content to ensure thoroughness and accuracy. Jennifer holds a JD from Indiana University Maurer School of Law in 2006. This article has been
viewed 228,316 times. Co-authors: 9 Updated: August 18, 2022 Views: 228,316 Categories: PowerPoint Presentations Print Send fan mail to authors Thanks to all authors for creating a page that has been read 228,316 times.
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